
Welcome to the Computerized Investing Spreadsheet Collection.

To your left, you will see the Shareware Collection’s navigation bar. Within are the
headings “SPREADSHEET” and “ACROBAT HELP.” Clicking on the triangles next
to the headings will open and close a drop-down listing of their associated sub-
headings. Beneath the topic “SPREADSHEET,” you will find a listing of all the
shareware products compiled on the CD-ROM alphabetically by name. Clicking on
any name will bring up the product’s associated information. Beneath the topic
“ACROBAT HELP” are the help topics the help file covers. It is recommended that
this be read if you have not had prior experience with the Acrobat Reader before.

Special Note:

The drive letter D: will be used for all references to the drive letter associated with
your CD-ROM drive.

Files ending in the Microsoft Excel extension .XLS need to be opened using an
Excel compatible spreadsheet program. Files ending in the Lotus 1-2-3 extension
.WKS need to be opened with a Lotus 1-2-3 compatible program, and files ending in
the Lotus 1-2-3 extension .WK4 need a Lotus 1-2-3 version 4 compatible program.

You will also note that Internet Web sites have been provided. Clicking on the blue
underlined text in the field “Web site” automatically launches your Web browser and
brings you to that Web site, provided you already have a connection to the Internet.

Click Here to Go to the First Spreadsheet Product >>



HartBetter Stock Analysis
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Excel

Enter stock prices, earnings, and dividends in the shaded blue areas. Buy, sell 
and maybe signals are then generated by the spreadsheet template.

Systems

 Any computer

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\BETTERST\STOCK.XLS

 Read Me Not Available Registration Fee:



Thomas BrennanCall Bull Spread
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Excel 5.0+

This project calculates a call bull spread, the historical variance, and implied 
volatility. It uses the Manaster and Koehler calculation, among others.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\CALLBULL\CBSPREAD.XLS

 Read Me Not Available Registration Fee:



Decision PartnerCredit Card Amortization
2960 West Camino Camelia    
Tucson, AZ   85745
(520) 743-4806

 $10.00

Requirements

 Excel 5.0+

This Microsoft Excel application will show you the term of your credit card balance 
and what percent of your spendable income is going to interest to pay off the 
balance. It will also allow you to see the effect of adding an additional payment to 
your normal monthly payment on your balance.

Systems

 IBM-compatible PC

E-Mail

76552.2221@compuserve.com

Web Site

Location of Spreadsheet and Readme files

 D:\CREDCARD\CRDTCOST.XLS

 Read Me Not Available Registration Fee:



Robert GilsteinDollar Cost Average Results
62 Tucker Lane    
North Dartmouth, MA   02747-3528

 Freeware

Requirements

 Excel 4.0+

Dollar cost averaging (DCA) is a simple and popular method for conservatively 
investing in stocks, bonds, and mutual funds. It reduces the risk of putting all your 
money in an investment just before a severe decline by investing a constant 
monthly amount over a stated period. This spreadsheet allows you to test the 
results of a DCA strategy over any length of time. You can set it to move funds 
regularly from a savings account or from your paycheck. Comparisons are made 
with investing all at once and with leaving in money market or savings account.

Systems

 Any PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\DOLLAR\DCA.XLS

 Read Me Not Available Registration Fee:



AAIIDuPont Analysis
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

This file contains a Lotus .WKS spreadsheet that performs a DuPont earnings 
decomposition analysis. The original article that describes the fundamentals of the 
analysis is also included. The user must provide the input data to perform the 
operations. Basic earnings, net income, equity, assets, and sales figures are 
required. A DuPont analysis breaks down a firm's return on equity into five distinct 
ratios that allow for further analysis of the earnings data.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\DUPONT\DUPONT.WKS

 D:\DUPONT\DUPONT.DOC Registration Fee:



Gil FrieseEE Savings Bonds 4 COLLEGE
1132 El Camino Drive    
Costa Mesa, CA   92626

 $12.00

Requirements

 Excel 4.0

This Excel spreadsheet calculates the value of U.S. Series EE savings bonds. The 
interest from U.S. Series EE savings bonds bought after 1989 can be tax-free if 
used for college tuition and fees. Enter the dates and total face values of bonds 
bought after 1979 and those to be bought in the future. The spreadsheet will 
calculate the current value of bonds already purchased and will estimate the value 
of all the bonds years from now. The spreadsheet also calculates yield-to-date, 
average market-based rates, and the return you would need from a fully taxable 
investment to equal the EE bond's performance.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\EE4COLLEGE\EECOLL.XLS

 Read Me Not Available Registration Fee:



GeorgeL605Excel 5.0 Investments
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Windows 3.1+, Excel 5.0

This spreadsheet calculates your retirement savings. The main file 'SEPP' is used 
in calculating penalty-free withdrawals of lump-sum tax-deferred money regardless 
of your age. As long as you abide by the IRS rules, early retirement penalty-free 
distributions are possible. Added to this enhanced version are two additional 
spreadsheets to help calculate your withdrawals and give you an idea of what you 
can expect to retain after every year using the plan. In addition, a separate sheet 
is added to allow you to quickly see where you are in your current savings, what 
you need, and how long it will take you to get to retirement.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\EXCELINV\2FREEDOM.XLS

 Read Me Not Available Registration Fee:



AAIIExcel Historical Market Data
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Excel 5.0

This file contains historical market data for the S&P 500. The file accompanies an 
article printed in the October 1995 AAII Journal. The following charts are 
displayed: S&P 500, S&P 500 (Semi-Log), S&P Yield & Index (1946+), S&P Yield 
& Index (1960+), S&P PE Ratio & Index (1946+), S&P PE Ratio & Index (1960+), 
Yields & Inflation, and S&P & Bond Yields

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\HMDATA\MRK40-95.XLS

 Read Me Not Available Registration Fee:



AAIIFinancial Planning
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

Includes a budgeting template, retirement planning template, rate of return 
calculator, portfolio management worksheet, and worksheet to calculate the 
average cost basis of a mutual fund investment.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\IBM12\IBM12.BAT

 Double click here>> Registration Fee:

Spreadsheet Collection
** This program needs to be run from DOS **
** This box can be moved for optimal readibility **

If in Windows, exit to DOS

If in Windows 95, click on the "Start" button, then select "Programs" and then "MS-DOS prompt"
 
Once in DOS, go to drive D:
(Where D is the drive letter of your CD-ROM drive)
by typing "D:" at the DOS prompt and pressing the "Enter" key

C:\>D:    Enter

Next, type

"CD\IBM12" and press the "Enter" key

D:\>CD\IBM12    Enter

Next, type "IBM12" and  press the "Enter" key

D:\IBM12>IBM12    Enter



AAIIFixed-Income Investments
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

Worksheets for analyzing the returns and risks associated with T-bills and bonds 
along with a bond portfolio management worksheet.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\IBM11\IBM11.BAT

 Double click here>> Registration Fee:

Spreadsheet Collection
** This program needs to be run from DOS **
** This box can be moved for optimal readibility **

If in Windows, exit to DOS

If in Windows 95, click on the "Start" button, then select "Programs" and then "MS-DOS prompt"
 
Once in DOS, go to drive D:
(Where D is the drive letter of your CD-ROM drive)
by typing "D:" at the DOS prompt and pressing the "Enter" key

C:\>D:    Enter

Next, type

"CD\IBM11" and press the "Enter" key

D:\>CD\IBM11    Enter

Next, type "IBM11" and  press the "Enter" key

D:\IBM11>IBM11    Enter




AAIIFundamental Stock Analysis
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

Templates for financial statement analysis using financial ratios, common size 
income statements and balance sheets, and DuPont analysis. Presents 
worksheets with stock valuation models such as the P/E relative model, dividend 
discount model, Graham earnings multiplier, variable growth model, price-to-sales 
ratio, and price-to-book ratio. Includes VAL2, the fundamental valuation template 
presented in the May/June 1994 issue of CI. Now includes data since 1940 
through on S&P 500 index earnings, dividends, and financial ratios. Also provides 
historical interest rates on corporate and government bonds.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\IBM9\IBM9.BAT

 Double click here>> Registration Fee:

Spreadsheet Collection
** This program needs to be run from DOS **
** This box can be moved for optimal readibility **

If in Windows, exit to DOS

If in Windows 95, click on the "Start" button, then select "Programs" and then "MS-DOS prompt"
 
Once in DOS, go to drive D:
(Where D is the drive letter of your CD-ROM drive)
by typing "D:" at the DOS prompt and pressing the "Enter" key

C:\>D:    Enter

Next, type

"CD\IBM9" and press the "Enter" key

D:\>CD\IBM9    Enter

Next, type "IBM9" and  press the "Enter" key

D:\IBM9>IBM9    Enter




AAIIGrowth Stock
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

This spreadsheet in Lotus .WKS format creates an estimated growth rate for 
earnings and a projected price for individual stocks. Based on data you supply the 
spreadsheet creates a fair value for the underlying stock.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\GROWTHST\GROWSTK.WKS

 D:\GROWTHST\GROWSTK.DOC Registration Fee:



ThomasPubHistorical Data
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 None

This is an ASCII text file of three month T-bill rates from 1973 to the present.

Systems

E-Mail

ThomasPub@aol.com

Web Site

Location of Spreadsheet and Readme files

 D:\HISTDATA\DTB3TA.TXT

 Read Me Not Available Registration Fee:



BTAGSInvestment Statistics
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Lotus 1-2-3 version 4.0

This is a program that will generate numerous statistics for investment evaluation, 
such as return, covariance, correlation coefficient, and more.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\INVSTATS\PROJECT.WK4

 Read Me Not Available Registration Fee:



GeorgeL605IRA Calculator
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Windows 3.1+, Excel 5.0+

This is an Excel 5.0 file that allows you to simulate the potential benefit of an IRA 
as a savings vehicle. By inputing five variables, you can automatically calculate 
into the future how much you could save over time. You can view the data for 
individual years to see how it changes annually. It also depicts the advantage of a 
tax-free savings plan, all else being equal. Information can also be viewed 
graphically. By inputting data based on what you feel you can realistically obtain, 
you can see just where you may stand years into the future. It also allows you to, 
on a limited basis, simulate an IRA you have in progress.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\IRACALC\IRA-CALC.XLS

 Read Me Not Available Registration Fee:



AAIILow-Load Mutual Funds
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

Ten years of performance data through 1995 on over 800 no-load and low-load 
mutual funds from AAII's "Individual Investor's Guide to Low-load Mutual Funds." 
Includes annual total returns, three-, five-, and 10-year annualized returns, bull 
and bear market total returns, comparisons of each return versus average return 
of funds with same objective, risk and risk rankings, beta for equity funds, 
weighted average maturity for bond funds, fund manager, and loads and 
expenses.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\IBM3\IBM3.BAT

 Double click here>> Registration Fee:

Spreadsheet Collection
** This program needs to be run from DOS **
** This box can be moved for optimal readibility **

If in Windows, exit to DOS

If in Windows 95, click on the "Start" button, then select "Programs" and then "MS-DOS prompt"
 
Once in DOS, go to drive D:
(Where D is the drive letter of your CD-ROM drive)
by typing "D:" at the DOS prompt and pressing the "Enter" key

C:\>D:    Enter

Next, type

"CD\IBM3" and press the "Enter" key

D:\>CD\IBM3    Enter

Next, type "IBM3" and  press the "Enter" key

D:\IBM3>IBM3    Enter




AAIIMarket Timing/Technical Analysis
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

Includes a template for calculating weighted moving average, portfolio allocation 
switching template, and a file listing annual DJIA close, earnings, and dividend 
information for the last 60 years.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\IBM13\IBM13.BAT

 Double click here>> Registration Fee:

Spreadsheet Collection
** This program needs to be run from DOS **
** This box can be moved for optimal readibility **

If in Windows, exit to DOS

If in Windows 95, click on the "Start" button, then select "Programs" and then "MS-DOS prompt"
 
Once in DOS, go to drive D:
(Where D is the drive letter of your CD-ROM drive)
by typing "D:" at the DOS prompt and pressing the "Enter" key

C:\>D:    Enter

Next, type

"CD\IBM13" and press the "Enter" key

D:\>CD\IBM13    Enter

Next, type "IBM13" and  press the "Enter" key

D:\IBM13>IBM13    Enter




J.E. MorrisMutual Fund Tax Data Calculator
P.O. Box 893    
Oswego, NY   13126

 $5.00

Requirements

 Excel 5.0

This spreadsheet determines IRS Schedule D information (reportable gains and 
losses) that arise from mutual fund transactions. Required inputs are: Transaction 
type (purchase or sale), transaction amount, and number of shares. Spreadsheet 
uses this information to report average cost per share for all transactions and a 
facsimile Schedule D for sale transactions. Share cost is determined using an 
average basis (single-category method).

Systems

 Any PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\MFTAXDATA\MUTALFND.XLS

 Read Me Not Available Registration Fee:



Brian WelkerOption Pricing
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Lotus 1-2-3 version 4.0

This file reviews option pricing using the binomial and Black-Scholes models.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\OPTIONPR\OPTIONS.WK4

 Read Me Not Available Registration Fee:



Thomas BrennanOption Pricing Model
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Excel 5.0

This project reviews the continuous time Black-Scholes option pricing model and 
the discrete time binomial option pricing model. The importance of option pricing in 
financial applications has been underscored by Richard Roll, a leading finance 
educator and practitioner, who argues it is at least as important as discounting 
arithmetic.  Much of our understanding of derivative securities and risk 
management techniques results from analysis similar to that in this project. 
Applications of option pricing techniques include capital budgeting and financial 
structure, among others.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\OPTIONPM\OPTIONP.XLS

 Read Me Not Available Registration Fee:



Empire Financial Sotfware, Inc.Portfolio Cow
P.O. Box 201    
Spokane, WA   99210

 Freeware

Requirements

 Excel 5.0, AAII's Stock Investor

Portfolio Cow calculates rate of return for portfolios created with AAII's Stock 
Investor, charts results, and compares portfolio performance with four stock 
market averages during the testing period.

Systems

 Any PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\PORTCOW\INSTALL.EXE

 Double click here>> Registration Fee:

Spreadsheet Collection
** This program needs to be run from Windows **
** This box can be moved for optimal readibility **

**WINDOWS 3.1**

If in Windows 3.1, click on "File" and then "Run."

When the dialog box comes up, type in:

D:\PORTCOW\INSTALL.EXE

Where D:\ is your CD-ROM drive, and press Enter.

Follow the setup prompts.


**WINDOWS 95**

If in Windows 95, click on the "Explorer" icon, then double click on your CD-ROM drive

For most, this will be D:\

Find the folder "PORTCOW" and double click on it.

Find the file "INSTALL.EXE" and double click on it.

Follow the setup prompts.




AAIIPrice to Sales Analysis
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

This spreadsheet analyzes a company based on its price-to-sales ratio. The user 
must input the data for each specific company. The original article is included in 
the self-extracting file.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\PRSALES\PSALE.WKS

 D:\PRSALES\PSALE.DOC Registration Fee:



AAIIRatio Analysis
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

This file analyzes several key ratios based on the fundamentals that you enter for 
each company. This analysis allows you to judge the strong and weak suits in 
fundamentals for every company.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\RATIOA\RATIO.WKS

 D:\RATIOA\RATIO.DOC Registration Fee:



Richard WeinbergRetirement Planning
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Excel 5.0

This is an Excel workbook that records current investments and calculates income 
at retirement and in years following retirement. It has several utilities including 
inflation adjustment and provision for lump-sum additions to and subtractions from 
investments both prior to and following retirement. What-if scenarios using the 
"goalseek" tool allow the user to set goals for future portfolio value and spendable 
income and perform a variety of other exercises.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\RETIRE\DICK.XLS

 Read Me Not Available Registration Fee:



Gil FrieseSeries E Savings Bonds
1132 El Camino Drive    
Costa Mesa, CA   92626

 $14.00

Requirements

 Excel 4.0+

This Excel spreadsheet calculates the values of U.S. Series E savings bonds. 
Enter the dates and face values of your bonds into the first two columns of the 
table. Calculated for each of your bonds are: purchase price, current value (within 
1 cent/$25 face value), current guarantee rate, yield-to-date, date when interest 
will no longer be paid, expected return 12 months from now, after-tax proceeds if 
redeemed, the fully taxable return required from a new investment to equal your 
bond's performance over the next year, and the months to redeem each bond to 
avoid losing interest.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\EBONDS\EBOND.XLS

 Read Me Not Available Registration Fee:



Gil FrieseSeries EE Savings Bonds
1132 El Camino Drive    
Costa Mesa, CA   92626

 $16.00

Requirements

 Excel 4.0+

This Excel spreadsheet calculates the value of U.S. Series EE savings bonds, 
bought in the past and future. Enter the dates and face values of your bonds into 
the first two columns of the table. Calculated for each of your bonds are: purchase 
price, current value, current guarantee rate, average market-based rate, yield-to-
date, expected return 12 months from now, after-tax proceeds if redeemed, the 
fully taxable return required from a new investment to equal your bond's 
performance over the next year, and the earliest month to redeem each bond to 
avoid losing interest.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\EEBOMDS\EEBOND.XLS

 Read Me Not Available Registration Fee:



HartSTOCK ANALYSIS
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Excel

Lets you view stocks in a spreadsheet for different ranges of buy, maybe, and sell 
opportunities.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\STCKANA\STOCKS.XLS

 Read Me Not Available Registration Fee:



Matt WynneStock Valuation
Information Not Available    NA
NA, NA   NA

 Freeware

Requirements

 Excel 4.0+

A stock price valuation template that uses a combination of the older AAII 
evaluator based on five-year historical numbers, and the techniques used in the 
Motley Fool investment forum on America Online. Data entry: five-year stock price 
high/low, earnings per share, cash flow per share, and dividends per share 
(valuable but not required). First Call and I/B/E/S earnings estimates forward two 
quarters and two years. Will generate valuation ranges based on five-year ranges 
of price-earnings ratio, price to cash-flow ratio, and yield, as well as PEG, YPEG, 
and k-g model.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\STOCKVALU\FOOLEVAL.XLS

 Read Me Not Available Registration Fee:



AAIISustainable Growth
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Spreadsheet that can read Lotus files

This spreadsheet can break down a companies earnings, dividends, and return on 
equity to create a sustainable growth figure for each company for which you input 
data. The original article is included in this file.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\SGROWTH\SUSGROWT.WKS

 D:\SGROWTH\SUSGROWT.DOC Registration Fee:



Hughes Financial ServicesTotal Investor - DOS
PO Box 1244    
Nashua, NH   03061-1244

 $59.00

Requirements

 Lotus 1-2-3 version 2.0+

Lotus 1-2-3 template combining multiple portfolio accounting, charting, and 
technical analysis into a single integrated macro-driven worksheet. Handles 
portfolios of stocks, bonds, options, mutual funds, and U.S. Treasuries. Technical 
analysis tools: charts, volume indicators, relative strength, moving averages, and 
momentum.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\IBM4\IBM4.BAT

 Double click here>> Registration Fee:

Spreadsheet Collection
** This program needs to be run from DOS **
** This box can be moved for optimal readibility **

If in Windows, exit to DOS

If in Windows 95, click on the "Start" button, then select "Programs" and then "MS-DOS prompt"
 
Once in DOS, go to drive D:
(Where D is the drive letter of your CD-ROM drive)
by typing "D:" at the DOS prompt and pressing the "Enter" key

C:\>D:    Enter

Next, type

"CD\IBM4" and press the "Enter" key

D:\>CD\IBM4    Enter

Next, type "IBM4" and  press the "Enter" key

D:\IBM4>IBM4    Enter



Hughes Financial ServicesTotal Investor - WIN
PO Box 1244    
Nashua, NH   03061-1244

 $59.00

Requirements

 Lotus 1-2-3 version 2.0+

Lotus 1-2-3 template combining multiple portfolio accounting, charting, and 
technical analysis into a single integrated macro-driven worksheet. Handles 
portfolios of stocks, bonds, options, mutual funds, and U.S. Treasuries. Technical 
analysis tools: charts, volume indicators, relative strength, moving averages, and 
momentum.

Systems

 IBM-compatible PC

E-Mail

Web Site

Location of Spreadsheet and Readme files

 D:\IBM4\TI123.EXE

 Double click here>> Registration Fee:

Spreadsheet Collection
** This program needs to be run from Windows **
** This box can be moved for optimal readibility **

**WINDOWS 3.1**

If in Windows 3.1, click on "File" and then "Run."

When the dialog box comes up, type in:

D:\IBM4\TI123

Where D:\ is your CD-ROM drive, and press Enter.

Follow the setup prompts.


**WINDOWS 95**

If in Windows 95, click on the "Explorer" icon, then double click on your CD-ROM drive

For most, this will be D:\

Find the folder "IBM4" and double click on it.

Find the file "TI123.EXE" and double click on it.

Follow the setup prompts.




AAIIValuation 1
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Excel 4.0, Lotus 1-2-3

Value Investing by John Bajkowski, editor of Computerized Investing. Perform 
stock analysis on individual firms using value investing techniques. IBM 
spreadsheet templates include Lotus .WKS and .WK3 files as well as Lotus for 
Windows. Excel 4 spreadsheets and the article as it appeared in the March/April 
1994 edition of AAII's Computerized Investing are also included in this self-
extracting file. Macro programming has been preserved.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\VALONE\VAL1.DOC

 D:\VALONE\VAL1.DOC Registration Fee:



AAIIValuation 2
625 North Michigan Avenue    Suite 1900
Chicago, IL   60611
(312) 280-0170

 Freeware

Requirements

 Excel, Lotus 1-2-3, Quoattro Pro

The second spreadsheet in the valuation series by Computerized Investing editor 
John Bajkowski. This spreadsheet enhaces the capabilities of market comparisons 
and analyses. The macro programming has been preserved for each spreadsheet 
included.

Systems

 IBM-compatible PC

E-Mail

AAIIMembr@aol.com

Web Site

 http://www.aaii.org

Location of Spreadsheet and Readme files

 D:\VALTWO\VAL2.TXT

 D:\VALTWO\VAL2.TXT Registration Fee:
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This online guide contains information to help you use the Acrobat Reader pro-
gram. For installation instructions and system requirements, see the 

 

README

 

 
file accompanying your software. Click one of the following topics to go to an 
explanation of that topic:

How to use this online guide

About Adobe Acrobat

The Acrobat Reader window

Status bar

Preferences

Using links

Using notes

Displaying documents in Full-Screen mode

Reading an article

How to upgrade
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How to use this online guide

 

Use these procedures to navigate through this guide:

Click underlined text to go to the topic indicated. Underlined text 
indicates text that is “linked” to another part of this guide.

Click the Go Back button in the toolbar to return to your previous 
location.

Click the Next Page button in the toolbar to go to the next page of 
the guide. 

Click the First Page button in the toolbar to return to the opening 
screen of this guide. 

Click the bookmark name to go to the topic marked by that book-
mark. Click the triangle to the left of a bookmark to show and hide 
subordinate bookmarks. The bookmarks for this guide provide a 
complete list of topics.

Click the arrow button to go to the next screen of any continued 
topic.

Topic

Distiller setu

How long 
Compres


About 
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About Adobe Acrobat 

 

The Adobe Acrobat product family consists of three products designed to bring 
electronic document solutions to a wide range of users:

 

•

 

Acrobat Exchange 

 

– provides all the software a business user requires for 
creating electronic documents from common applications. Included in Acrobat 
Exchange are the Acrobat Exchange viewer and PDF Writer for creating and 
modifying electronic documents. Acrobat Exchange includes Acrobat Search 
for full-text searches of indexed Portable Document Format (PDF) files. The 
Acrobat Exchange product also includes the Acrobat Reader for Macintosh

 



 

, 
Windows

 



 

, DOS

 



 

, and UNIX

 



 

.

 

•

 

Acrobat Pro

 

 – combines Acrobat Exchange and Acrobat Distiller

 



 

. Acrobat 
Distiller converts any PostScript

 



 

 language file into PDF. Set up Acrobat 
Distiller to convert PostScript files on a local Macintosh or Windows computer, 
or to monitor directories on a network file server, which provides Distiller 
conversion services to any number of network users.
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•

 

Acrobat for Workgroups

 

 – provides everything a workgroup of 10 requires: 
10 licenses of the Acrobat Exchange viewer for Macintosh and Windows, 1 
license of Acrobat Distiller, and Acrobat Catalog

 



 

 to create indexes for 
full-text cross-document searches.

To find out how to order Acrobat products, click one of the following topics:

How to upgrade Order form
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The Acrobat Reader window

 

You open a document in the Acrobat Reader window. You can display 
bookmarks or thumbnails in an overview area to the left of the document.

Beneath the menu bar at the top of the window is the toolbar; at the bottom left 
of the window is the status bar. At the right of the window is a vertical scroll bar 
that enables you to scroll up and down through a document. The overview area 
of the window includes an independent scroll bar that you can use to scroll 
through bookmarks or thumbnails. 

See these topics for more information about the Acrobat Reader window:

Status bar fields and controls

Tools and buttons
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Tools and buttons

 

The toolbar contains tools for selecting and viewing documents. Select a tool by 
clicking the tool icon. To hide or show the toolbar, choose Hide Toolbar or 
Show Toolbar from the Window menu.

The toolbar contains the following tools and buttons:

Click the 

 

Page Only

 

 button to close the overview area of the window. 

Click the 

 

Bookmarks and Page

 

 button to open the overview area and 
display bookmarks created for the document. Click a bookmark’s name 
to go to the location marked by that bookmark.

Click the 

 

Thumbnails and Page

 

 button to open the overview area and 
display thumbnail images of each document page. Click a thumbnail to 
go to the page marked by that thumbnail.

Use the 

 

hand

 

 tool to move a document page on-screen when it does not 
fit within the window. Drag the hand tool in the direction you want to 
move the page. 
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Use the 

 

zoom

 

 tools to magnify and reduce the page display by a 
factor of 2.

Use the 

 

select text

 

 tool to select text in a document, which can then be 
copied to the Clipboard by using the Copy command. Choose Select 
Graphics from the Tools menu to select graphics in a document.

Use the 

 

Previous Page

 

 or 

 

Next Page

 

 button to move the document 
backward or forward, one page at a time.

Use the

 

 First Page 

 

or 

 

Last Page

 

 button to move the document to 
the first or last page of a document. 

Use the 

 

Go Back

 

 and 

 

Go Forward

 

 buttons to retrace your steps in 
a document, moving to each view in the order visited. Go Back 
also returns you to the original document after you click a link to 
another document.

 Click the 

 

Actual Size

 

 button to display the page at 100 %.

 Click the 

 

Fit Page

 

 button to scale the page to fit within the window.
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 Click the 

 

Fit Width

 

 button to scale the page to fill the width of the 
window. Pressing this button and the Option (Macintosh) or Control 
(Windows) key fills the window with only the visible text and graphics 
on the page.

Click the 

 

Find

 

 button to search for part of a word, a complete word, or 
multiple words in a document.

Click the 

 

Web Browser

 

 button to start your Web browser. If your Web 
browser is already running, it becomes the active application. 

If the Web Browser button does not appear in the toolbar, make sure you 
have the Weblink plug-in installed and that the Show Toolbar Button 
option in the Weblink Preferences dialog box is selected. (To set the 
Show Toolbar Button option, choose Edit > Preferences > Weblink.)
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Status bar fields and controls

 

The status bar contains the following fields and controls:

The 

 

window splitter 

 

adjusts the width of the overview and docu-
ment areas. Drag the control to where you want to divide the two 
areas.

The 

 

page number box

 

 displays the current page number and lets 
you go to a specified page in a multipage document. Click the page 
number box to display the Go To Page dialog box.

The 

 

magnification box

 

 displays the current page magnification 
and lets you select various magnifications. Choose Other from the 
menu to display the Zoom To dialog box.

The

 

 page size box

 

 shows the size of the current page by using the 
units specified in the Preferences dialog box.
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Preferences

 

The Preferences items in the Edit menu allow you to set preferences that affect 
all the Acrobat documents you view.

 

General preferences

 

Choose Preferences > General to set these options:

 

•

 

Default Magnification

 

 is the magnification that Acrobat Reader uses when 
documents are opened. 

 

•

 

Max Fit Visible Magnification

 

 is the maximum magnification for Fit 
Visible and for viewing articles. The Fit Visible option automatically selects the 
appropriate zoom level to display the visible elements of a page.

 

•

 

Display Large Images

 

 displays large images without replacing them as gray 
boxes. A large image is an image that requires many bytes of storage and that 
takes a long time to display.

 

•

 

Use Page Cache

 

 may reduce the amount of time it takes to page through a 
document.
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•

 

Greek Text below [_____] pixels

 

 displays the size of characters below 
which Acrobat Reader 

 

greeks

 

 characters (displays characters as gray 
lines). Increasing the size of greeked characters speeds page display.

 

•

 

Substitution Fonts

 

 controls which multiple master fonts Acrobat Reader 
substitutes for Type 1 fonts that are not available on your system.

 

•

 

Page Units

 

 displays the units of measurement (inches, millimeters, 
or points). 

 

•

 

Display Splash Screen at Startup

 

 displays the product splash screen when 
you start the Reader viewer.

 

•

 

Display Open Dialog at Startup

 

 displays the Open dialog box when you 
start the Reader viewer.

 

•

 

Maximize Application on Opening

 

 (Windows only) maximizes the 
application window to fill the entire display. 
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Full-Screen preferences

 

Choose Preferences > Full Screen to set these options:

 

•

 

Change pages

 

 specifies mouse and keyboard control, or automatic 
advancement every specified number of seconds.

 

•

 

Loop

 

 displays the document continuously, looping from the first page to 
the last.

 

•

 

Background color

 

 specifies the window’s background color. 

See Displaying documents in full-screen mode for instructions.
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Displaying documents in Full-Screen mode

 

Choose View > Full Screen to make the PDF document fill the 
entire monitor screen.

The characteristics of full-screen documents are set through the Full Screen 
Preferences dialog box. See Full-Screen preferences for more information.

The pointer remains active during Full-Screen mode so that you can click links 
and open notes. Thumbnails and bookmarks are not accessible in Full-Screen 
mode.

The following tools and commands are accessible through their command-key 
shortcuts:

 

•

 

All View menu commands except Page Only, Bookmarks and Page, and 
Thumbnails and Page

 

•

 

The Hand, Zoom-In, and Zoom-Out commands in the Tools menu

To exit from Full-Screen display mode, press the Escape key, or advance past 
the last page.
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Using links

 

Creators of PDF documents can create hypertext links that connect two parts of 
a document. Links can connect part of a PDF document to another PDF docu-
ment or to another application file, such as a spreadsheet or movie. Links also 
connect PDF documents to documents on Web servers.

 

To use a link:

 

Click any text or graphic that is identified as a hypertext link. The pointer 
changes to a pointing finger when positioned over a link. When moved over a 
Web link, the pointing finger contains a W.

 

To return from a link to a PDF document:

 

Click Go Back or choose Go Back from the View menu to return to the previous 
page view.

 

To return from a link to a Web document:

 

Make the Acrobat window active.
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Using notes

 

When you encounter a note in a PDF document, double-click it to open the note 
window. To find the next note in the document, choose Find Next Note from the 
Tools menu.

To close the note window, click the close box in the upper left corner of the note. 
(Macintosh users can also press Command+W.) 
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Reading an article 

 

Creators of PDF documents can define document 

 

articles

 

 that automatically 
guide you through sections of a document. 

 

To read an article:

 

Choose View > Articles. (The menu item is dimmed if no articles exist in the 
document.) The Articles dialog box appears.

Select the article you want to read from the title list, and click View to go 
directly to the beginning of the article, or click the beginning of the article with 
the hand tool. Place the hand tool pointer on any box in the article. 

If you start at the first article box, the pointer changes to Read Article 

 

D, and 
the status bar shows Read Article. 

Click anywhere in the article or press Enter to follow the text of the article view 
by view. 

To return to the previous view of the article:
Hold down the Shift key and click. 
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To return to the beginning of the article:

 

Hold down Option/Ctrl and click. 

 

To exit an article at any time:

 

•

 

Select any navigation method other than pressing Enter or Return.

 

•

 

Go to another article or page. 

 

•

 

Click + Shift + Option (Macintosh) or Shift + Ctrl + Click (Windows). 

 

Note

 

: If you exit an article by going to a specific page using Go To Page or the 
toolbar buttons, the page is displayed with the Default Magnification prefer-
ence setting. The magnification in effect while you read the article is not used.
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How to upgrade
If you’re using Acrobat Reader to view a Portable Document Format (PDF) file 
created by someone else, you can do much better with Acrobat Exchange 2.1 for 
just $195 (U.S.). Outside North America, contact your local Adobe reseller.

Acrobat Exchange 2.1 for Macintosh or Windows includes:
• Acrobat Exchange and PDF Writer for creating your own PDF files

• Acrobat Search for full-text search and retrieval of files indexed with 
Acrobat Catalog

• Acrobat Reader for Macintosh, Windows, DOS and UNIX to view and print 
your PDF files

In North America, to order or to locate the Adobe authorized reseller nearest 
you, call 800-521-1976. Please mention offer number 9-02-02-9.

Alternatively, print or fax the order form to 408-655-6096, or mail it to: Adobe 
Systems Incorporated, P.O. Box 6458, Salinas, CA 93912-6458.
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